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0. Contents of the Water Supply Network GIS Database User’s Manual with 
ArcReader CD-R 

The Water Supply Network GIS Database User’s Manual with ArcReader CD-R consists of following 
file structure. 

 
1. Install ArcReader on your computer and copy the Geodatabase of Sadr City into 
your hard disk 
1.1 Hardware Requirement 

The list below provides the minimum requirements for installing and running ArcReader. 

� Computer: An industry-standard personal computer with at least a CPU Speed 800 MHz minimum 
recommended or higher Intel-based microprocessor, a hard disk, and a CD-ROM drive. 

� Available hard disk space: The disk space requirements for each of the ArcReader components are 
provided in the Setup program. 

� RAM: To run ArcReader, you’ll need at least 256 MB RAM (512 MB recommended) for viewing 2D 
map documents, 512 MB RAM (1 GB recommended) for viewing 3D map documents. 

� Operating system: Microsoft Windows 2000 or higher, or Windows XP Home Edition or higher. 

� Display Properties: Greater than 256 color depth. 

Setup requires approximately 50 MB of disk space for temporary files while installing ArcReader. 

1.2 To run the ArcReader Setup program 

(1) Start Windows. Make sure the Water Supply Network GIS Database User’s Manual with ArcReader 
CD-R is in the CD-ROM drive. 

(2) From the Start button, click Settings, and then click Control Panel. Double-click the Add/Remove 
Programs icon. On the Install/Uninstall tab, click the Install button. Browse for the [CD-ROM 
drive]:¥ArcGIS_ArcReader¥setup.exe executable located on the Water Supply Network GIS 
Database User’s Manual with ArcReader CD-R. Click the Finish button. 

(3) When Setup starts, follow the instructions on your screen. 
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Click Next button. 

(4) Appear License Agreement. 

 

 

 

 

 

 

 

 

 

 

 

 

Select I accept the license agreement. Then click Next button. 

(5) Appear Select Installation Type window. 

 

 

 

 

 

 

 

 

 

 

 

 

Select Typical. Then click Next button. 
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(6) Appear Destination Folder window. You can change to install into a different folder. 
Click the Browse button and select another folder. 

 

 

 

 

 

 

 

 

 

 

 

 

Then click Next button. 

(7) Appear Ready to Install the Application window. 

 

 

 

 

 

 

 

 

 

 

 

 

Click Next button. 
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(8) Start installation. 

 

 

 

 

 

 

 

 

 

 

 

 

(9) Appear ArcGIS ArcReader has been successfully installed window, when the installation 
was finished. 

 

 

 

 

 

 

 

 

 

 

 

 

Click Finish button. 

 

1.3 To uninstall ArcReader 

The ArcReader software components can be uninstalled easily, if necessary. From the Start button, click 
Control Panel. Double-click the Add/Remove Programs icon. On the Install/Uninstall tab, select the 
ArcGIS ArcReader program from the programs list, then click the Remove button. 
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1.4 To copy the Geodatabase of Sadr City 

(1) From the Start button, right-click, and then click Explore. Browse for the [CD-ROM 
drive]:¥GDB_Pilot_Area_JICA on the Water Supply Network GIS Database User’s Manual with 
ArcReader CD-R. Click the Finish button. 

 
2. Quick-start tutorial 
2.1 Exercise 1: Viewing a map 

In this exercise, you will open and explore a published map with ArcReader. You will also use 
ArcReader to query data on the map. 

Starting ArcReader 

1. Click Start on the Windows taskbar. 

2. Click Programs, point to ArcGIS, and click ArcReader. ArcReader opens. 

 

 

 

 

 

 

 

 

 

 

Opening an existing published map 

1. Click File and click Open. 
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2. Click the Look in dropdown arrow and navigate to the map folder on the local drive where you 
installed the Geodatabase of pilot area. (C:¥arcgis¥arcexe82¥ArcTutor is the default location.) 

 

 

 

 

 

 

 

 

3. Double-click Gulf of St. Lawrence.pmf. ArcReader opens the map. 

ArcReader can open published map files (.pmf) that have been created in ArcMap using Publisher. The 
map document sotres map elements, such as titles, scalebars, and North arrows. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This particular map contains the following layers in a data frame named Gulf of St. Lawrence: 

Layers   What layers contain 

Links to Web Sites  Internet addresses 

Cities   Locations of population centers 

Major Roads  Locations of expressways and primary highways 

Base Map  Land and coastline layers 

A data frame is a frame on the map that display layers in the same geographic area. 
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The map portrays the Gulf of St. Lawrence and the surrounding region. Notice that there are check boxes 
next to each layer name in the table of contents. All layers that are checked are drawn in the map display 
area. 

Moving around a map 

The Data toolbar has tools to move around the map and query features on the map. Point to each icon, 
without clicking, to see the name of each tool displayed in a ToolTip. This manual will use these names 
to refer to specific buttons and tools. When you interact with the map, one of these tools will be active 
and the pointer will change to the active tool when moved over the map. 

 

 

 

 

If you need more information about how a tool or command works, you can quickly access the 
context-sensitive help that is available for most tools. Press Shift + F1 on your keyboard while pointing 
to the tool. 

 

 

 

 

 

 

 

1. Click the Zoom In tool, then click and drag a box around Anticosti Island and a portion of the St. 
Lawrence River. This will make it easier to read the labels and see where the cities and roads are 
located. 

 

 

 

 

 

 

 

 

 

2. Using the Pan tool you can interactively manipulate the map. Click the Pan tool, then click the map 
and hold down the left mouse button to drag the display in any direction. 
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3. The Go Back and Go Next buttons can be used to revisit any of the places to which you have 
previously zoomed or panned. Click the Go Back button now to view the previous map extent. 

 

 

 

 

Using bookmarks 

Bookmarks are named map extents created by the publisher of the map. The publisher zooms to a specific 
view of the map and saves it for future use. You can access the publisher’s saved extents by selecting 
Bookmarks. 

1. Click the View menu, point to Bookmarks, then click Prince Edward Island. 

 

 

 

 

 

 

 

 

 

 

The map now shows Prince Edward Island. 
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2. Click the View tab, point to Bookmarks, then click Gulf of St. Lawrence to reset the map to its 
original display. 

To learn how to set bookmarks, see Using ArcMap. 

Turning layers on and off 

The table of contents is where you turn map layers on and off. To display a layer, check the Layer 
visibility check box next to its name. To turn the layer off, uncheck the box. 

1. Check Links to Web Sites. 

Notice the blue question mark symbols now draw on the map. 

2. Uncheck the Links to Web Sites. 

Notice that the layer is turned off and no longer displays on the map. 
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Getting information about layers 

Each of the layers in a map has a set of properties that can be viewed, allowing you to learn which 
features are available for that layer. 

1. In the table of contents, right-click Major Roads and click Properties. 

2. Click the General tab. 

 

 

 

 

 

 

 

 

 

 

You can see whether the layer is displayed at all scales or only within a specific range of scales and 
whether Map Tips have been enabled for the layer. Map Tips are onscreen descriptions of map features 
that appear when you point to a feature. Later in this manual you will use Map Tips from this layer. 

3. Click OK to close the Layer Properties dialog box. 

Using the Magnifier Window 
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There are times when you may not want to change the location displayed on the map but still need to see 
more detail. The ArcReader Magnifier Window allows you to do this. 

1. Click Window and click Magnifier. 

The Magnifier Windows opens. 

 

 

 

 

 

2. Click the title bar of the Magnifier Window and drag it over the map. While you are dragging it, the 
Magnifier Window will show crosshairs to indicate which part of the display will be magnified. 

3. When the crosshairs are over the portion of the map you would like to magnify, release the mouse 
button. You will see a magnified view of the location under the magnifier. 

Changing the Magnifier Window properties 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can change several properties o the magnifier window, such as the magnification factor and what the 
magnifier window displays. 

1. Move your courser near the edge of the Magnifier Window, then click and drag he cursor in the 
direction you want to resize the windows (make it a little larger). 

2. Place your cursor in the middle of the Magnifier Window and right-click. 

3. Point to Magnification Factor and click 800%. This will scale the data displayed in the Magnifier 
Window by the percentage chosen. 

4. Right-click the Magnifier Window and click Lock Magnifier. Move the Magnifier Window 
somewhere else; notice that the picture doesn’t change, but instead keeps your snapshot. 
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5. To re-enable the magnifier, right-click the magnifier window and click Lock Magnifier again. The 
window redraws to magnify the section of the map it is over. When you have finished experimenting 
with the Magnifier Window, click the Close button to close it. 

Data view and Layout view 

ArcReader is capable of displaying a map in either Data view or Layout view. Up to this point this 
manual has been using Data view. Data view shows the contents of a data frame. Layout view shows the 
map as it would appear on a printed page. Layout view also shows map elements that aren’t contained 
within the data fame, such as the map title, legend, scale-bar, and North arrow. 

1. Click the View tab and click Layout View. 

 

 

 

 

 

 

 

 

The map displays in Layout view. Notice the page includes a title, legend, scale-bars, and some 
supporting text. Also displayed is the Layout toolbar, which contains tools for navigating in Layout view. 
Point to each icon, without clicking, to see the name of each tool. 

The Layout tools in the Layout toolbar are used like the tools in the Data toolbar. They allow you to 
change the way the page is displayed. Notice that the data tools are still accessible for changing the view 
of the data within the data frame. 

There is a shortcut for switching between Data and Layout view. In the scrollbar near the bottom of the 
map, there are three small buttons. Clicking the globe icon switches to Data view, clicking the page icon 
switched to Layout view, and clicking the arrow icon refreshes the map. 
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In this exercise, you learned various ways to view a published map in ArcReader. In the next exercise, 
you will learn how to query a map in ArcReader. 

2.2 Exercise 2: Querying a map 

A map in ArcReader typically contains more information than you initially see. For example, a feature 
may hold attribute information that is not labeled or displayed on the map. With ArcReader you can 
query that information or use Map Tips to find a feature on the map. 

Using Map Tips 

The most readily accessible kind of map attribute information comes in the form of Map Tips. Map Tips 
contain an attribute chosen by the map author that displays whenever you hover any data tool over a 
feature on the map. Map Tips are only visible while in Data view. 

1. Click the Data View button, located at the bottom-left part of the map. 

2. Click any data tool and point to a road to see its name. 

 

 

 

 

 

 

 

 

 

The Major Roads layer is the only layer in this map that has Map Tips enabled. You can tell if Map Tips 
are enabled for a layer by right-clicking the layer name in the table of contents and clicking the General 

14

tab on the Properties dialog box. 

Identifying a location 

You can use the Identify tool to get two kinds of information – you can see which features are at a 
specific location and also investigate the attributes of each feature. 

1. Click the Identify tool. 

The Identify window opens. 

 

 

2. Click the Identify from dropdown list and click <Visible layers>. 

 

 

 

 

 

 

 

 

 

3. Click the View menu, click Bookmarks, then click Prince Edward Island. 

4. Click the dot that represents the city of Charlottetown. 
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Notice that the Identify tool located not only information about Charlottetown but also information about 
the Major Roads, Coast lines, and Land. The identify results include all visible layers. 

Identify window commands 

Right-clicking features, layers, or their attributes in the Identify window opens a context menu with 
options for working with the fields for that feature or layer. 

 

 

 

 

 

 

 

 

 

 

1. Right-click a layer or feature. The options in the context menu allow you to zoom to features, center 
features, expand all the fields, collapse the Identify tree, sort the fields, or copy a record. 

2. Right-click an item in the Value column. The options in the context menu allow you to organize the 
Field values. You can hide or show all the fields, select all the fields, change the order of the fields 
(inverse selection), or copy all the fields. If you click Copy, you can then paste the information into 
another application, such as a text editor or a spreadsheet. 
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3. Click the small dropdown button to the right of the Location text box to open a menu that will allow 
you to display the location of the city in the units of your choice. Click Meters. 

4. Close the Identify window. 

 

 

 

 

 

 

 

 

Finding a location 

In ArcReader it is easy to find a feature based on an name or value using the Find tool. 

1. Click the Find tool. 

The Find dialog box appears. 

 

 

 

 

2. In the Find text box, type “Lourdes”. 

3. Click the In layers dropdown arrow and click <All layers>. 

4. Click Find. ArcReader locates the city called Lourdes and shows it as a row in the Results section of 
the window. 
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Once you’ve found a place, you can use the Find dialog box to navigate to or learn more about the 
feature. 

5. In the Find dialog box, right-click Lourdes and click Zoom to feature(s). ArcReader zooms to the city 
of Lourdes. 

6. Make sure the Find dialog box does not cover the city of Lourdes. In the Find dialog box, right-click 
Lourdes and choose Flash feature. Lourdes will flash. 

7. Right-click Lourdes and click Identify feature(s). The Identify Features on the Map dialog box, 
which contains all the attribute information for the city of Lourdes, appears. 

 

 

 

 

 

 

8. Close the Identify Features on the Map dialog box and the Find dialog box. 

Measuring distance 

You can measure distances in ArcReader. The ArcReader Measure tool allows you to see how far apart 
two places are or even plot a route and check its distance. 

1. Click the View menu, point to Bookmarks, then click Measured Journey. 

2. Click the Measure tool on the Data toolbar. 

 

 

 

3. Click Port-Cartier, then plot a course through Gaspe Passage and on to Cope St. George by clicking 
each time you want to change directions. 

4. Double-click on Cope St. George to finish measuring. The line you drew disappears. 
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There are a few things to notice as you do this. First, on the ArcReader status bar in the lower left, you 
will see the current segment’s length. Second, you will see the total distance you have measured. 

 

 

 

In this exercise, you learned various ways to query a published map to get more information from it. You 
learned about Map Tips and the various tools that ley you investigate more closely the information a map 
contains. In the next exercise, you will learn how to print a map in ArcReader. 

2.3 Exercise 3: Printing a map 

To perform the following exercise, you will need to have a printer available. The printer should be able to 
print a A4 size sheet of paper and can be either a black-and-white or color printer. 

1. Click the ArcReader File menu and click Page Setup. 

The Page Setup dialog box opens. This dialog box contains options that let you change which printer you 
are using or change the setting for that printer. 

2. If the printer you want to print from is set as your default printer, skip to Step 3. Otherwise, click 
Printer in the Page Setup dialog box and choose the printer to which you want to print your map. 
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3. Click Landscape. 

4. In the Printer Setup box, click the Size dropdown arrow and click A4. 

Note that it is possible to print this map to a larger or smaller paper size by checking the Scale to fit Page 
check box in the Page Setup dialog box. The map will scale up or down to fit the page. 

5. Click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

Printing a map 

1. Click the Layout View button. 

It’s important to switch to Layout view because your printing results can vary depending on what view 
you are in. Printing in Data view will print the currently displayed data frame at the current extent to the 
selected paper size. The printed data will be scaled to fit the page size selected in Page Setup. When 
printing from Layout view, however, the entire published page is printed. 

2. Click the File menu and click Print. 
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3. Click OK. 

In this manual you have been introduced to viewing, querying, and printing published maps with 
ArcReadeer. 

 

 

 

 

 

 

 

 

 

 

 


